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BACK PADDOCK

Adviser and Manager are whole farm planning,
paddock based recording, reporting and mapping
software programs. Both programs can assess
profitability and risk as you plan and come with a
comprehensive list of crop, variety and chemical

Inputs, and all an be easily added or edited.

Plans can be viewed as maps with links to soill
samples. The farms physical resources such as sol
types, tree plantings and contours can also be
displayed on a map. A farm rotation analyser and

a crop water use calculator@aiadded features.

Adviser and Manager programs are powerful,
accurate, easy to use and compliant with most
management systems including yield and paddock

maps from farm machinery.
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About Adviser / Manager
BACKGROUND TO THEBW®WARE

Adviser wa®riginally developed to provide Agronomists with a means to quickly provide their
clients with detailed paddockased agronomic plans for the coming season while allowing the
flexibility to modify the plan as the season progressed.

Those who previously haystems based around combinations of word processors, spreadsheets
and databases found Adviser to be a single comprehensive solution that reduced preparation time
substantially and provided a more integrated and professional looking product.

The softwarehas continued to evolve and expand to suit the requirements of farmers as well as
Advisers while maintaining ease of use and the original core aims of the software:

A To provide fast and efficient agronomic planning
A Reduce repetition and save time
A Utilise dda to provide useful information to help with decision making and communication

Adviser software is to be used as an integral piece of farm machinery throughout the entire farming
year. We believe it can add much value to a farm business by improvedmjacommunication
and informed decision making

ADVISER EDITIONS

The Adviser family of software is available in several flavours to suit different user requirements and
budgets.

U Adviseris aimed at Consultants, Advisers, Agronomistsngioae who needs to use the
BACK PADDOCK software for Multiple Clients.

Adviser

U Manageris aimed at farmers or those who wish to use the software for a single farm
BACK PADDOCK business entity.Manager does not include all the functions of Adviser

Manager

Both of these versions ate @I A f ILited SO 3 Nkt d2ngtancludeGIS Mapping and a number
of other features.

Adviser / Manager User Guidepage5




>
BACK PADDOCK
USING THIS GUIDE

Throughout this guide the following symbols are used to help you better understand the software.

These are:

These arét K I 2 &  LINI Qhavwid Guidélyiny,

Exercises through all the steps to complete a key task

new users

An explanation of the data field¢hat you will
Table Layout encounte in the data entry tables as you use the

| |
| |
F Pointers Useful tipsto help you avoid some of the pitfalls of
- software

l'Yy20KSNJ O2y @Sy i(iAz2y GKI G @ 2 Ghese aré dsed foyndicadzyhicB NJ A a
menu commands you use to achieve a specific function. For example, to close thenpyagra

select the File menu and then the Exit menu contained in the File menu. The menu Path form of this
is [File/Exit]. A more advanced example could [Mapping/Layer Library/Saved Layers/Retrievel].

Simply start at the main application Menu and work yauaty through.

Similarly Keyboard Shortcuts are denoted[lz /CEA ]

The Guide has been structured to take you through each section of the software in a logical manner
to get you up and running as quickly as possible. The Guide has been designed to bddtexdale

as either a selpaced tutorial, training course notes and as a reference source as required.
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Chapter I¢ Getting started

In this chapter you will familiarise yourself with licencing the software, requesting support, the
software user interface and the process of getting ready taupetour first Client File.

1.1LICENCING

Licence Manager

The licence manager is accessed through the Help section via the confifedpd Licence

Managel. This will then bring uphe licence manager window where information on advisor
licences can be obtained. There are four sections in the licence manger that consist of the licence
current status, licence product comparison, licence agreements and licence requests.

Licence Curren$tatus

This window displays the status information on the licence currently used by the computer. The
status of the licence is then displayed in the right hand section along with the expiry date, last
accessed date, issue date, current time and produafigaration.

Product Comparison

The product comparison section shows a table with all products offered by Back P&tzloplany
In the neighbouring columns are the products description and its limitations. This section is
important in determining what prodgct would best be suited for your particular needs.

Licence Agreement

This particular section of the report displays the licence agreement for the software
issued. It is important that this is read and understood before purchasing and using the
software.

Licence Request
The licence request section has three aspects to it, which consist of the user details, privacy

statement and request licence.
1. The user details section determines which product you wish to request and also the name and

location for the sdfvare. Choose a particular product and then enter in the details below.

2. The privacy statement then explains that all the information provideBack Paddock Company

is kept confidential.

3. The request section then displays the particular product and idength at the top of the

window. If the information is correct then simply click on the send email request to obtain the above

Adviser / Manager User Guidepage?




product. To save the request form for another time, simply click on the save quAeékfiPl&lﬁ[g&&K

be saved in a particulan¢ation for future reference.

1.2SUPPORT

The help section at the top of the page can be used to describe certain aspects about the program,
access the Back Paddackmpanyy S6 A A GS> RAaLX & fAOSyOS Ylyl 3S
the support page.

If any problems are encountered whilst using this program there are a number of options that can

be used to overcome the problem or situation. The first step would be to find the particular section

in this users guide and follow the steps and procedures asifetl. If the problem persists or is not

found within the report then other options can consist of:

1. ContactEree call help deskn 1800 557166 during 7aifpm EST

*If issues with the software, users must be on thgest versionso under help check for uptss
when on line before contacting the help desk as often an enhancement in the latest version

may satisfy your enquiry.

2. Group Training, Back Paddockdviser/Managetraining is available in group sessions with a
minimum number of 10 required. Manager@Manager Litdraining can attract government
subsidies such as FarmBis. All training delivered by Certificate IV, Training and assessment
accredited trainers.

3. Master Data Basean up to date Master Data base can be emailed to users vpguest and
includes the most of the current seed varieties, fertilisers, operations, timings and chemicals
that could be used on farms in Australizefault costs and application rates are also included.

4. Demonstration CD copiesvailable free upon regest, email a request to

support@backpaddock.com.aar phone 1800 557 166. The demonstration CD allows users to

adjust details in two paddocks of a sample farm fliso included is a video explaining the
features of Back Paddodidviser/Managera tutorial and a testimonial by an experienced user.

5. Customised reportsdetailed customised reports can be created on a fee for service basis.

Adviser / Manager User Guidepage8

NI



mailto:esupport@backpaddock.com.au

BACK PADDOCK

Chapter &; Seting Up the Farm

In this Chapter you will learn how to set up the Client File with farms and their associated
paddocks. This will form the backbone of all future work done on this file and the
presentationof summaries and Reports.

FLE MANAGEMENT

The native document type for Adviser is the "ADV" file. This file can contain data for any number of
farms, paddocks and management zones for any number of years.

It is usual for one client file contain the data of oa farm business entity.

To create your initial Client File, compldéigercise 1After this exercise you will be ready to start
adding farms and paddocks, which is covered in the next chapter.
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CLIENT DETAILS

Each Client File can contain client information to
used when printing reports or as a general

reference.

To view or edit Client details go to mertkilg >
ClientOption® @ ¢ KAa gAff ahlL]
dialog. Select the Client Detaith and edit fields

as required.

BACKINGJIP& SAVING DATA

Before we move on we will cover the very
important topic of making sure you do not lose
your data once you have invested the time in

entering it.

HOW DOES ADSER SAVE
DATA?

While you are entering data the software
constantly writes changes to your client fiéer

updating each entry.

You can easily tell when this occurs as when you
start to edit the symbol at the left of the table row
youare editing changes to.# . After editing is
complete and the data is saved to disk the symbo
changes to . There is no need to manually save
as this is automatic each time you update. If the

program crashes or the computer is closed the

E]S

BACK PADDOCK

N

 Selet New From the File menu (or the New
button LI on the Toolbar)

Check that the path to the correct Drive and
Folder is correct so you will place it where
you want it and you can find it later.

K Exercise 1

Create a new Client File

e il

The recommended and default location for client
files is in;

Sy ¢eMyDEIMeénfsB&K & hLIGA 2y &
Paddock/Software/Adviser/Clients

This Folder is created during installation and is
default location when you create a new file.

1 Enter a name for the file

Naming Client files by the farm business nam
the preferred practice. This naman be used
later in report headers.

A filename can contain up to 255 characters,
including spaces. But,éannotcontain any of
the following characters:

\ /. *x?2" <>

It is essential that the file has tie® | R @£
extension. It is possibke accidentally change
the file name extension when renaming files.

1 Select Save to create new file

Your newly created file will now be open ready to
start entering data.

If it is necessary to change a file name, this can be
R2y S Ay (KS (selkdifeitdile ad t S

Windows Explorer.

data will reman intact provided the storage disk is

operational. To protect against a loss of storage

click right mouse button), or alternatively in
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device you must make a baclp copy to a different storage device. BACK PADDOCK

BACKING&PCLIENT FILES

To backup your client filehe easiest method
Ad G2 das GKS 9ELJZN?{- Oldzld / tASyd CAES | zﬁ
Menu command located on the File Menu Pointers for BackindJp Data

WCAfSH 9ELERNIB .. Ol|dzZlJ / tASyid CAtS | aX686
CKAA FdzyOlGAzy ahLBylae KA Gefip thehpbiy g backingp gligry fijes after
save dialog where you can direct it to a neyw each time you make significant changes
location. If desired you can alserrame the A If you lose the client file you will heto start
file at this time. again from scratch. The file is an investment ¢
Examplef where to backup are: your time. You can never have too many
_ . backups.
1 USB Thumb drive S )
?ﬁ A We have heard from many devastated users
1 Burnto CD . -
who did not baclup their file. Some examples

1 A networked hard are;

drive on a different 0 Laptop stolen from car

PC o Hard disk failure

You can backp the file anywhere data can o Accidentally ogrwrote or deleted file
be stored. o Electrical storm fried PC
Alternatively you can back up files manually A A backup saved in a different location would

using Windows Explore \ have prevented loss in all these cases /

{1"+£9 /[ L9OVMENUWIOMBIAND{ X
This command is only used when you wish to save the Client file as a different name and make the

new name the active file. The existing file remains unchanged after this point. This is useful for doing
G2 KI G A @séthodagdBuch chld should be taken to ensure data remains complete in the

desired file.

It is not recommended that this function be used to bacip data.
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The initial step in creating a new client figeto set upthe client details To do this, go tpFle>Qient
Options]. This will bring up an additional window that will enable you to enter all the relevant details

for the particular client file.

Configuration | Client Details
Trading Mame:

Mame:
Surnae:

Address:

Tovwr:
State: Postcode:
Phore:

Phore 2:

Fax:
I obile:

Email

The next step in configuring a new Clié&iiie is to set up the farm. Once farms and paddocks are

added the program is ready to go.

Click on the Farm Tab at the top of the page to proceed in setting up your farm.

ManagemegVVFarm rRDtatiDns r.ﬁ.nalw;.-'sis rRainFaII rCash Flo rLivestDck rInventu:ur';.f rRep-:urts rMapping ]

MULTIFARM
. @ RSTFlLdz G 2yS T NY Ol thd tisof filel ceati®. [{Gherbld énly ané O NS |
farm for the client filehen you may wish to change the name of the farm. This is done in the-Multi

Farmsection. Press th button to view this.

The MultiFarmdialog provides the following functions:

Add a New Farm
1) To add a new farnpress the Add butto

2) Name the new farnand any other details in the table.

3) Close the MultFarmdialog when complete.

Adviser / Manager User Guidepagel?2
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Changing farm sort order BACK PADDOCK

You can change the order of farms by selecting the row containing the farm you wish to move and

then pressing either of up or down buttons in the tooIE

This order iszised for all navigatioand presentatiorthroughout the program.

DeletingFarms
To delete a farm, select the row of the farm you wish to delete and press the Delete g |n.

x  NOTE THAT DELETING RMANILL PERMANENTLY DELETE ALL DATA FOR THAT FARN
INCLUDING ALL PADDOCKS, ALL INPUTS FOR ALL YEARS. USE WITH CAUTION!

Report Images

In the Report Imagedialog you can add graphics files to be included in tipeme These could be: a
diagram, photo or map or any bitmap or jpeg file. These will appear in reports before the farm they
are linked to.Take care to not use images that are too large and can fit within A4 page margins.

The Restructure Paddocks section allows
to change farm structure without data loss.
This is covered later.

Multi-FarmData Details

\

/
j Table Layoutc Farm Table (MultFarm Box)

Exclude Excludes selected paddock from Navigation, summaries and re
Farm Name Name of farm to be presented throughout all displays
Rainfall o | Average annual rainfall for farm

LocationID | o | Unique farm IDor use in Adviser Analyser software

Notes Any permanent details for the farm

k 0= optional j

SETTIN®&P PADDOCKS

The paddock table on the Farm page allows you to allocate any number of paddocks to a particular
farm. The table can only include the paddocks from the currently selected farm.

This is seby using the drop lisbn the toolbar If there is only one farm in the Client file then there is
farm.

no need to set the current

Harne Farm

Away Farm

Adviser / Manager User Guidepagel3
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F When initially setting up the farm you may wish to use

Quick Entnyffeature, which can be seen below.

Adding Paddocks
Having selected the current farm (if more thane farm) you can begin to add paddocks. To do this,

select the Add buttoon the toolbar@

The cursor will be ready in the Paddock Name cell so you can begin typing the name immediately.
Hit the Enter key and the cusor will move to the Area cell where you can type the paddock area

immediately.

Quick Entry
The Quick Entrjeature allows you to automatically add a new paddock after editing the

area cell and pressing the EnteReturn key on the keyboard. This can make it easy to work

through a list of paddock names and areas using minimal keystrokes.

Be careful when on the last paddock not to add an extra paddock. If you do, then simply delete the
surplus paddock.

Insert Faddock
The Add buttoralways adds a paddock to the bottom of the list. Alternatively you can insert a

paddock by selecting the paddock that you wish a new paddock to appear above and then selecting

the Insert buttan instead of the Add button. A new paddock appears above your current

selection.

Deleting a Paddock
To delete a paddock, select the row of the paddock you wish to delete and press the Delete button.

NOTE THAT DELETING A PATXOWILL PERMANENTLY DELETE ALL DATA FOR THAT PADDOCK
INCLUDING ALL INPUTS FOR ALL YEARS. USE WITH CAUTION

Sorting Paddock Order
You can change the order of paddocks by selecting the row containing the paddock you wish to

moveand then pressing either of up or down buttons in the toolldarmove the paddock in that

direction.E This order is used for all navigatiand presentatiorthroughout the program.
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PADDOCK TABDATA DETAILS

/:I Table Layout Paddock Table (Farm Tab)

\

Exclude Excludes selected paddock from Navigation, summaries and report
Paddock Name Name of paddock to be presented throughout all displays

Area Area in Ha to be used as default throughout

Soil Details ¢} Description of soil type for paddock

Boundary (notincluded inLiteversions) t NBa & (2 ahlLISyé LI RR20O1 02dzyRI
Arable (notincluded in Lite versions) t NS & & (2 ahlLISyé LI RR20O1 FNrofsS
Rain Site o Rainfall collection site relevant to this paddock

Notes ¢} Any permanat details for the paddock

-

O = optional /

/ F Pointers for settingup the farm \

A

Start by renaming the Home Farm and adding any additional farms in the ¥atin

section

Add paddocks to each farm in the order you wish them to be presented througho

the program

o Enter paddock area as you go as thssiinportant later when you start
entering data
.S OFNBTFdA y2G (G2 AyOfdzRS lye GeLRQa

used throughout the entire package

Take care not to add additional paddocks (particularly when using Quick Entry m

or famms that are not required as this can cause problems later on

Adviser / Manager User Guidepagel5
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1.

10.

11.

12.

13.

14.

15.

16.

BACK PADDOCK

Exercise 2
Adding Farms and Paddocks

'aS GKS /fASylG FAES @2dz ONBIGSR Ay
GhLISY¢ Al Y260 ¢2 &IOSV S KENEISEHHBK & M.
button on the toolbar

Select the Farm Tab on the Main Screen

Select the MultiFarm button on the Toolbar

tt1 0S8 (GKS OdzNA2NJ Ay GKS CINXY blYS O
Select Add new farm

Type a new farm name for the secofadm. The cursor will be ready to overwrite
GKS RSTlIdzAZ G abSég CIFNY HéE YIYSO

Select the second farm and change the sort order up and down.
Close the Farms Dialog

Select a farm that you wish to add paddocks to using the drop list on the Farm*

toolbar

Seli GKS ! RR odzid2zy |yR (KSy (&L
M €

Hit Enterl on the keyboard and then type the area of the paddock

Press Quick Entry on the toolbar once to set Q#inky mode

Add a new paddock as before

Type the name and pss entefl

Type the area and press enter - A new paddock should have been added

Repeat steps 14 and 15 until all desired paddocks are complete
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Chapter 3; Navigation BACK PADDOCK

In this Chapter you will get an initial feel for how the clientidilstructured for data
associated with paddock operations. The concept of the Managerduerdis to see how we
input data and navigate to view the data we want to see.

THE MANAGEMENTEWc WHERE IT ALL HAPPENS

Most data entry in Adviser is performed in the Managem¥i@w. This view is activated by selecting

the Management Tab on the main Client screen.

/ Managerment rFarrn rFlcuI:aI:iI:uns r.ﬁ.nalysis rFlainFaII

The ManagemenYiew is dived into a number of Panes. With the exception of the Navigation Pane,

all panes are used to enter or view data

MANAG EMENZONES| Managemenkt Znne|
¢ KS {SmddementeRy Sé A& dzaSR Ay ! ROAASNI (G2 NBFSNI i

timeframe. This is generally a paddock in a given year, though can be a part of a paddock in the case
of split paddocks. Later you will see that inpats allocated to Management Zones. This section will
cover the methods of moving between Management Zones to select the sections related to them

and allow you to view, add or edit data for a particular zone.

Adviser / Manager User Guidepagel8
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NAVIGATION PANE Navigation | BACK PADDOCK

To move between paddocks you must use the Navigation Pane.

Summaryand Rotatiorscope can also be set using the Navigation Pane to select different levels

such as All Farms, Selected Farm, Selecteddeadut Selected Usage.

The Navigation Pane has several modes of presentafibese are:

Management | Farm Rotations Analysis Rainfal

— E 9§ Normal Mode- Tree shows hierarchy of Farms and
Mavigation i |

Bl = = | Paddocks. See example to the left.

+& {demofarm (3555.0 ha);
-« Avonlea (2411.0 ha)
Box

Creek

Header

Horse

Ironbark
Kangaroo
Kurrajong
Malles

One Tree
Cutside Pivot 1
Pine Tree

Pivot 1
Quandong
Rosewood

Sand Hill

Sheoak

Wattle Park
Wilga

[z Green Swamp {11440 ha)
Church

Five Fifty Acre
Fox

MNorth Creek
Morth Machinery Shed
School

Morth Foad

Ram

Shearing Shed

Cee bbb bbb d

AR RN RN NN

Management | Farm Rotations Analysis Rainfall

|Na~.-'igatiu:n i ‘

<& demofarm (2008).

Bl \(f Arrowleaf dover
<& Shearing Shed

Wf Barley feed

Wf Barley malt,

Wf Canola

\(f Lupin (augustifolius)

WY Mustard

Wf Oats hay

Wf Pea

Wf Subdover

Wf Wheat ASW

Wf Wheat APH

Wi Wheat ASW

Wf Wheat year 2

1{; 1 Crop Mode- Tree shows hierarchy of Crop typ

and Paddocks. See example to the right.

E-E-E-E-E-E-E-E-E-E-E
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Management | Farm Rotations Analysis Rainfal

Navigation P = 1 Link Mode- Tree shows paddocks / master paddocks
= \{@DZ-- as parent nodes of any paddocks or management
& demofarm (2008) _ ] o

< Paddock 2 - Cane ratoon ¥r 2 zones that are linked to them using paddock linking.

<& Box - Canola
=9 Church - Wheat ASW See example to the left.

& Morth Machinery Shed
& Paddock 2 -

<& Paddock 2 - Avocade

& Paddock 3 - Pineapple
-4 Creek - Wheat year 2
& Sheoak
Paddock 3 - Broad beans
Header - Wheat APH
Fox - Barley malt.
North Creek - Wheat ASW
Horse - Mustard
Ironbark - Wheat APH
Kangaroo - Subdover
School - Barley malt.
Morth Road - Barley malt.
Kurrajong - Canola
& Cutside Pivot 1
& Rosewood
Ram - Qats hay
Mallee - Wheat APH
One Tree - Canola
Shearing Shed - Arrowleaf dover
Pine Tree - Barley feed
Pivat 1 - Wheat year 2
Quandong - Lupin (augustifolius)
& Five Fifty Acre
-4 Sand Hill - Pea

& Wilga
& Wattle Park - Subdowver

HGe bbb b d

m

m
E X RN NN N

Management | Farm Rotations Analysis  Rainfall

Mavigation a

B =)
Iz O & 0 M @ S B

- 1 Map Mode - (not included in Lite versionsPaddock

map allows navigatiofy paddock boundary selectior
or keyboard arrows. Use mouse wheel to zoom. S

example to the right.

_:.
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In the normap modes where a hierarchical treeused, navigate by initially selecting a paddock

from the tree. Selection of paddocks can then be by:
9 Selecting another paddock using timouse
9 Using the up or down arrows on the keyboard

9 Typing the first letter of a paddock to move to (can be repeated until correct paddock is

selected)

THE FARM YEAL « » | 2005
Data input and summary is considered inf \

terms of a Farm Yeafhe Farm Year is sef F
The Farm Year can also be set using keyboar

shortcuts.

Pane.To change year select the left or [7 A+ ]to move to the next year

[7 Z- ]to move tothe previous year.

in the toolbarof the ManagemenZone

right buttons to move to the previous or

next year respectively. By default the

program opens in the current year. K j

The Farm Yeas not necessarily a calendar year. The starting month may be important for dates in

the Cash flow or Diary sections.

The starting month of the Farm Yezan be set by selecting meffile>Client Optionshnd

choosing a month in the drop down list.

PLAN& ACTUALSIODE [=pian | |[$2actuss

While navigating, it is also important to be aware of the RBi@tus. By default a Client File opens in

Plan mode. Plan mode is for lookifogward to costs and actions that have not yet occurred.

Throughout the year actuatsan be added with the real situation without overwriting the plan.

To switch between Plaand Actual mode press the button on the Main Toelbéou can also use the

menu commandView>Actuals]

You can also toggle between Plan and Act
mode by using the keyboard shortcut
[7 A£A]
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Chapter 4 The Master Database BACK PADDOCK

In this Chapter you will find out about one of the single most powerful components of the software,
The Master Databaserou will learn howhis database interacts with your Client File to reduce
repetition and maintain consistency for summaries and reports.

4.1 WHAT IS THE MASR DATABASE?

The Master databass common for ALL client files. Its purpose is to:

1 Save tine by not having to retype product and other input names

1 Maintain default prices, yields and usage rates

1 Allow users to configure dregown lists to their own specifications

1 Standardise terms and groupings for use in Reports, Summaries and Histoiiyy(Qual
Assurance)

=
The Master Database can be opened from the Tools Menoabbutton

QMaster Database - B X

File Edit Wiew Records Help
e B A w A A K2

= iCrops | = Crop Category

+ Broadleaf {Dicat) E| b |Broadieal [Dicat]
Marrow leaf (Monocat) Marrow leaf Manocat)

¥
+ Fallow Fallqw
¥ Horticulture Enrtlculture
£ Pasture asture

= Fertilisers
[FF agrichem Plant Mukrition ©

[FT BioAg

[FF M Rural -
4| i | »

For Help, press F1

Prices in the Master Database are default only, and can be overwritten at any stage in the client file

Changes to the Master DatabageRE NOautomatically reflected in Client files, though can be

manually updated per year by using Tools > Update client from master.
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When entering names, bear in mind that this is how they will appear in summaries and reports. Note
also that the dropdown listsin the client files will sort these by alphabetical order and so the

naming convention should facilitate the fast find feature of pressing the first letter of an input.

The Master databasis structured to allow you to Add, Modifr Exclude items under the headings

¢ Crops/Fertilisers/Chemicals/Operations/Timings/Production/Livestock and General.
Images as bmp files can be added in the Timings section and show in the Spray Program Report.

Utilise the+and¢ buttons to collapse théranch and expose the contents under each heading i.e.

Cropsg Broadleaf/Fallow etc

Crops - Broadleaf You can utilise the EXCLUDE tick box (tick to exclude) to remove certain
~_ | Exclude|Crop items from your drop down selections in PA that you do not wish to see.
2 \% ’Eﬁaﬁﬁea i.e. controls what appers in lists certain Fertiliser suppliers or blends etc.

Values are copied from the Master Database to Client Files when using.Btophese values then
become part of the Client File and will remain as such until they are either overwritten orateskle
from DropList. Using the Update From Master Command on the Tools Menu of the Main Program

can refresh updated details in the Master.

The Master databas€ A £ S a! ROAASNRI &G SNWPLIVE A& Ay ihSHNOKI y
is located under yowBack Paddock Softwarkedviseka I 8 G SNJ 5F G RANBOG2 NE f

520dzySyia¢ o
To share your Master Database with another user you are required to Export your database as a
*.pm file by selecting File/Export Master Aglecting a directory where you wish to Save your

database file and then giving the File a name in the File Name box. Select SAVE to create the file in

the selected directory.

When you have sent your database to another user of Adviser/Manégey need to Save the file

G2 GKSANI RANBOG2NER 2F OK2A0S IyR (GKSYy ahLXSyé
To utilise your master database on their copy of Adviser/Man#g®r need to select File/Set

Master File and then use the BROWSBEON to select the appropriate directory where they saved

your master database copy with a *.pm extension. When found, select the File name by clicking on it
G2 KAIKEAIKG FyR GKSy aSt800G aht9béad | 2N RI @
of PA. To revert to your original database simply select the RESTORE DEFAULT option on the same
page.
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You can also PRINT your selections for Crops/Fertilisers/Chemicals and Operations by utilising the

PRINT LISTS option, and if need be control #tigidi the EXCLUDE option within each sub heading
group

. Exercise 4.1
. Adding and Deleting Master Database
items

Adding a new item
1. ahlSy¢ GKS YIFadSNI RIGEFEOFAS
2. Select Herbicide in the Navigati tree.
3. Inthe sub groups within Herbicide select Gravpslycine
4. Select the add button. A new row will appear at the base of the group M Table in th
right pane.
5 TRR I yS¢g LINRPRdzOG OFfftSR ay2 FNARffa |
the details.
6. You may wish to sort at this stage as the order in this table persists in the drop dow
in the main program. To do this, select the sort button from the toolbar.
Deleting an Item

1. Deleting a product is very similar to adding, lets delete the pcbave just added,;
2. {StSOG GKS LINRPRdzOG (2 RStSGS ay2 FNACE
ChemicaldHerbicideM Glycine then the product
3. {StSOG GKS RStSGS odzitizy 2y GKS G2L)
minimise the herbicide sectipby selecting the minus button adjacent to herbicide.
Excluding an ltem

1. Excluding items is just as easy by ticking the box adjacent to the item to be exclude
2. Select the item to be excluded then tick the box. Select fertilisers then tick the supp
companies that you do not deal with
3. Select another item that you may never use and exclude it, select operations then t
a product.
modifying an Item

1. Modifying an item is just a matter of typing over the existing figures. Commonly rate
per hectare, costsral expected yields and returns are areas that need to be checke:

2. Select crops Broadleaf (Dicot) and change the yield and $/T value figures for canol:
Select ChemicalderbicidesAchieve WG and change the cost and default applicatior
rate to $90 and .38380 grms)
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There is an up to date master data base file available on the back
paddock website  www.backpaddock.com.au or by request via the help

desk on 1800 557 166 7am

support@backpaddock.com.au

-7pm EST or email

Chapter 5; Data Entry

Ly W KbL®@®3INII aA2y Q> G§KS O22¢ne $aslintrodlu€ed and dasa | y |
defined as a particular piece of land over a given time&at this point we should revisit
the Management Zone as it is at the core of all our input data entry.

COMMON METHODS FORTERING DATA

Throughout the software the process for adding, editing or deleting records is consistent. The

common buttons are a®llows:

[ 3

7.8

Add new record to bottom of table

Delete selected record

Shift record up one row (change sort oriler

Shift record Down one row (change sort orf

Copy plans to actuals

Note that deleting a record is permanent with no undo function,

however you are always prompted to prevent accidental data loss,
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5.1 MANAGEMENSECTION BACK PADDOCK

L/Management rFarm rRDtatiDns r.ﬁ.nalysis rRainFaII rCash Flo rLivestu:uck rInventDry rRepDrts rMapping ]

By default each paddock has a Managemémnhe deined for each year. This simplifies the data

entry process considerably unless we wish to split a paddock into two or more Management Zones.
As the Management Zone is usually defined by its crop type or rotation status it follows that this is
the best plae to start entering data.

The crop type can be set either on the Managem¥igw or the Rotations View. The Rotations
section can be a good place to plan the whfalem cropping program in one place without the
distraction of inputs otkr than seedRefer to Rotations section).

MANAGEMENZONE DATA

Management Zone

1 b | 2008 | k¥ B | Blend Dress Production Irrigation | Flags | = | bt El | |

Primarily the data entered in the Managemefane table is the crop type and seeding rate
information. Available data fields are summarised below.

| Crop Type Wariehy $/T ha kg/ha Drate Symbol | Footnote

/—=| Table Layout Management Zone Table \

(Management Tab)

Crop Type Crop Type name from Master List

Variety o | Variety name from Master List

$IT Seal price in dollars per tonne

Ha Seeding area of this Management Zone

Kg/ha Seeding rate in kilos per ha

Date o | Seeding Date

Pasture o | Indicates pasture (necessary to allocate livestock paddo
U/Sow o | Indicates zone is under sown

Blend o | Indicates blended seed

Grade o | Indicates graded seed

Irrigated | o | Indicates zone is irrigated

Summer | o | Zone is a Summer crop

Symbol o | Footnote symbol used in reports

Footnote | o | Notes for Zone. Also used as zone footnote in reports

\ O = optional /
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In addition to these fields, buttons on the Managem&wine toolbamprovide access to other tables
for data linked to the currently selected zone

BLEND 4 » | 2006 | »# ¥ | Blend Dress Production Irvigation | Flags | @ | &% s | |

Opens the seed blend dialed@ his dbws any number of seed varieties to be used on one zone.

DRESS 4 » | 2006 | »% ¥K | Blend D?Lss Production Irtigation | Flags | @ | b - | . |

Opens the seed dressing dialoghis is used to apply any product to seed at a constant rate per 100
kg of seed. Examples are seed fungicides, inoculants etc. Currently inoculant ratakalated on

the sowing rate of the main crop grown and not the undersown pasture, so in this situation enter
the amount of inoculant required for the pasture seed per paddock

PRODUCTION 4 » | 2006 | »# WK | Blend Dress Production Irvigation | Flags | & | &% a8 | .|

Opens the production dialogHere you can enter grain productidor the zone. Production can be

entered in any number of loads and quality / price information recorded.

IRRIGATION 4 » | 2006 | »+ W& | Blend Dress Production Irrigation | Flags | &= | k% == | |

Opens the seed irrigation dialed his section allows water costs and volumes to be attributed to
zone. (This section currently undemvation/enhancement)

FLAGS 4 » | 2006 | »# WK | Blend Dress Production Irrigation | Flags | & | b% s | . |

Selecting the flags tab exposes the check box flags that consist of pasture, u/sow, Blend, Grade,
Irrigated, Summer, Hort. and Perm. Check the corresponding boxes to the relation of the paddock.

When checking the Horticultukrand Permanent boxes, new options then become available to edit
Haort. | Pemn. R[] Plart{rn]

data in.

Share Farming 1 P} | 2006 | (X 4 | Blend Dress Produckion Irrigation | Flags | = | % E‘ | 5]

/I tAO01AY3 2y GKS aKIFENB FIENXYAYy3 GFo oNRy3Ia dzZd i

designated Share farming status. In this window you are abléjtestthe percentage of income and
costs that are attributed to the particular share farmer. Clicking on the Edit Share Farmers tab allows
you to enter key associated notes about the particular share farmers. When a paddock has been

designated as a shararfn, then a symbol will appear in the navigational tree to indicate that the

particular paddock is share™
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The share farming cost splitup can also be changed in the fertiliser and operations sections of each
paddock although it defaults to the figureglected in the client options area if changes are not
made.

Note: To enable farm sharing you must first apply it in File>Client options ¢

PADDOCK NOTE 4 » | 2006 | b4 KK | Blend DCress Produckion Irrigation | Flags | = | %ﬁ - | e |

The show paddock note from farm section is an important function as it displays the notes from the
farm section in the management section and also in the report. It is useful in remembering key
issues or points of interest within the selected paddock. The notes are displayed above the paddock
name in the management tab and are displayed under the crop/tasiection in the report for each
paddock.

Other functions on the Manageme#ibne toolbar

4 » | 2006 | »# ¥ | Blend Dress Production Irrigation | Fla|;|5|| & | bl | | |

@ Exposes paddock linking field in Managem&one table

= | Opens coverage map editor for zoff®t includel in Lite versions)

| Displays paddock note from Farm View at top of Managerdeni table

4

Opens Share Farming dialog
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5.2 DATATABS BACK PADDOCK

! Fertiliser

Fertiliser | Sprays | Operations | Summary | Diary | Forecast | Gross Margins | General | Water Use Efficiency | Rotation Anabyzer

The data panes consist of 10 different sections that range from ferslisethe rotation analyser. In

these panes certain management adjustments and decisions can be made.

Fertiliser

: Fertiliser

Fertilizer rSprays rOperatiu:uns rSummar\,-' rDiary rFu:urecast rGru:uss Margins rGeneral rWater Lze Efficiency rRDtatiDn Analyzer

Each of the following tabs in the fertiliser pane are shown below:

E Moves Selected

b Add

7.3 Remove / Delete

Btz Copies plan data to actuals

. | Opens coverage map editor for applicatigmt included in Lite versions)

Histary Opens fertiliser history / nutrient audit dialog
Tests Opens soil/plant tests dialog

Eements ~ Exposes fields iRertiliser table that contain elemental analysis for fertiliser prod

Primarily the data entered in the Managemefdne table is the crop type and seeding rate
information. Available data fields are summarised below.
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Fertiliser Fertilise name from Master List

Cost ($/T) Fertiliser cost in dollars per tonne

Area Fertiliser spreading area in ha /F \
Kg or I/lha Application rate in tones per ha Take care when
Elements x 12 Elemental analysis b applying liquid

Timing o | Timing description from Master List IR |29

that the price is $/T
Date o | Application date and the analysis is by
volume. If the bulk

Liquid Indicates the fertiliser is a liquid e
density is not
BD (tm’°) If liquid then a Bulk Density is required here included for liquis
Share % o | Percent cost contributed by share farmer then the summary
: totals may be wrong.
Symbol o | Footnote symbolsed in reports

Footnote o | Notes for application. Also used as footnote in repo

N y
- /

FertiliserHistory
The fertiliser history section derives information from actual data rather than plan data. Once a

FSNIAEA&ASNI KIFa 0SSy O2YLWAESR Ay (KS LXIy asSoi

from the plan section to the actual sectio/E&
*2 AGK2dzi GKS RIFEGEFE Ay GKS WwWI OldzZftQ aSOGA2Y GKS
when the fertiliser history window is displayed.

The Fertiliser history button displays a new window that displays the paddocks fertiliser history over

a selected period of time. To determine the number of years that are displayed for the paddock

KA&G2NEZ 58t3800G G(KS aONRE{f R26Yy YSydz Ay G(GKS @8

years back you want to view the paddocks fertiliser histi veas

b

E
3
2
3
4
5
B
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other columns consist of the crop grown in that particular year, the fertiliser applied during the year,
the area applied, kg or I/ha, the date atite nutrients by kg/ha. To display the nutrient audit, simply
check the box at the top of the screel¥] Hutiient Audit This will then display extra rows within the year

that determine the removed nutrients per T/ha. To print the fertiliser history simply click on the

BACK PADDOCK

Once the number of years are determined the years will displayed in the left hand side column. The

print button located at the top left hand of the scree&k

Exercise
Adding Fertiliser

letd I RR FSNIAfAASNI (12 &2dzNJ LI RR2014ao
GKS WYIylF3asSYySyagQ GFroT

Select a paddock, click on the fertiliser tab then press the Addrdutton for

the Fertiliser table, and select a fertiliser from the Drop down arrow in the
fertiliser column. Add a granular fertiliser such as DAP to be applied by a drill at
seeding. Fertilisers can also be deleted in this manner using the deletent’™ it
Fertiliser can be sorted by using the up/down tog¢ - #cated at the top left of
each table. This sort order will be used in reports.

Click on and complete the other cells to the right including cost, application rate
timing and sowing date.

Ifyouy2¢g aSt SO0 GKS WwWOoftSYSyidaé odzidzy
elements are being applied.

Lets presume you need more nitrogen, again select the Add Record t"* tand
select urea. Applied this product at 50kg/ha at growth stage 39 on 1/09/B§06
air. It is the same procedure if you were to add a fluid fertiliser, the only differen
being you need to tick the liquid fertilise box so that the bulk density of the
product is taken into account when analysing applied elements.

Fertilisers can atsbe deleted in this manner using the delete but™\ Fertiliser
can be sorted by using the up/down togg ~ focated at the top left of each table.
This sort order will be used in reports.

Fertiliser history and a nutrient audit can be viewed by seledtirchistory

button.
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Sprays

FertilisgVVSprays rOperations r5ummar3-' rDiar\,.r rFDrecast rGI’DSS Margins rGeneraI r'l.-'u'ater LUse Efficiency rRDtation Analyzer l

The spray pane contains three different sections that consist opinay manageymix and

chemicals

Spray Manager
The spray manager section allows you to adjust whetherobryou want to view the chemical or
adjuvant on the corresponding screen. This can simply be done by checking-ehdaking the

desired box.

Mix Compon... e

Shiow
Chericals

Shiow

Adjuvants

CKSNBE INB (2 OASg Y2RSa G2 OK22aS FTNRBY Ay GKS
andthS WadzyYlI NBE GASsQad

P # Edit View Summary Yiew

Each of these views are as their name suggests with the edit view enabling you to edit the sprays

and the summary view providing you with an overall spray summary for the paddock.

Whilst in the summary view you are also able to cleotige specific details you want to display by
checking or urchecking the boxes. Once you have your desired display you have the option to print

the sheet by selecting the print button

Options

[ Show
Zhem

[] Show
Zhem

[] Show
\Waker

[] Show
adijuvants

[] Show
Footnotes
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Functions on the Sprays Mix toolbar

&~ - pk FE E Hiskory % Defaulk Water Rate (LfHa): |30 b Zonc. Spraying

Move the selected mix up or down

b Create a new mix

) Delete the current Mix

i Coverage Map

el Show the spraying history
B Copy Plans to Actual

DU el (=D Adjust the default water rate

% Show/Hide Sprayed Area (defaults to 100%)

COnc, Spraving

Concetrated Spray

The default water rate can be adjusted to apply to each new mix by simply entering a new water

rate figure in the provided section.

Default Waker Rate (LfHa) 30

The mix section determines the required water mix with the chemical/s for the particular paddock

that isbeing sprayed.

belist ha Water Lsha | Runoff Léha | Water Beg. L | Target Speciez | Timing [ ate
M1 1] an 1500

By ticking the Conc. Spray box, you are adjusting the spraying method to a concentrated spray, as

used in horticulture, rather than a broad acre spraying method. “2ne: Spraying

A new column then appears which allows for the runoff rates to be akiland included in to the

spraying calculation. Runaff LAha
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/j Table LayoutMix Table (Sprays Tab) \

Mix Displays the numbered mix

Ha The area to be sprayed

Water L/ha Water rate (default rate can be changed above|
Water Req. L Calculated water required

Target Species o | Lists the Targed Species for the Chemical

Timing o | Crop stage

Date o | Spraying date

Notes o | Additional notes

Runoff L/ha o | (Active when Conc. Spraying checked)

\ o= optional /

Chemicals/Adjuvants
The chemical/Adjuvants section allows you to choose the particular chemical that is to be used on

the particular paddock. This is done by simply clicking on the scroll down @rfawthe chemical

space and choosing from the list the particular chemical degized

Chemical [Iritg
p DI vl L
-
Ao
Ablantis
Atrazine 500 gai
Afrazine 600 gai
®_ Atrazine WG 900 gai

Avades =THRA

Aial
Balance
Barracuda
Barrel
L |Baytan C w

Chemical History
The chemical history operates in the same respect as the fertiliser history. The same steps are

required in order to display the number péars for the chemical history as in the fertiliser history.

Years |3 W

F5FGF Ydad 0S8 WwWHOhdd tQ REGE FYyR y2i WLXIFyQ HI

The columns display the year, crop of the particular year, chemical class, group, type, chemical brand

name, units, uris/ha, area, date and the timing.
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To print the chemical history simply click on the print button located at the top left of the window.

=

. {StSO0 I LFRR201Z OfAO] 2y UGUKS &LINIe@

Exercise
Adding Chemicals

Lets add chemicals to your paddocks. Your cligdtfly SSR&a G2 6S a
iKS WYLyl3sySydQ GFoT

mix table, and select the specific water levels required, target species, timing, da
and add any particular notes relation to the chemical and paddock. To change th
default water rate simply enter in the top of the pane. The mixes can also be dele
in this manner using the delete butt™ . Mixes can be sorted by using the
up/down toggles - located at the top lefof each table. This sort order will be used
in reports.

Once the mix is complied, it is time to add the chemicals to the mix. This is done
the chemical pane below the mix pane.

/| tAO01 2y GKS WIRR OKSYAOIf Q 0 dainiey I
chemical column to choose a particular chemical.

To add an adjuvant to the mix, click on the adjuvant tab located at the bottom of
screen. The same steps are then repeated as when adding a new chemical to th
mix.

Chemicals and Adjuvantsrche deleted using the delete buttc™ . Chemicals and
Adjuvants can be sorted by using the up/down toge,~ iscated at the top left of
each table. This sort order will be used in reports.

Chemical history can be seen in the history button located atdipeof the pane.

To view a summary of the particular chemicals being applied to the paddock, clic

on the summary tab in the view window to the left hand side of the chemicals par
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Operations

Fertiliser rSpray_f;/Operatiuns rSummary rDiary rFu:urecast rGross Margins rGeneral r'v'-.-'ater sz Efficiency rRDtatiDn fnalyzer ]

The operations pane allows you to input the particular operations that will occur within the paddock

at a particular point in time. In this section you are able to link particular operations to other

activities.
/ —=| Table LayoutOperations \
Operation Choose the type of operation
Details Details you may wish to enter about the operation
Area The selected area
Cost ($) Calculated cost
Timing o | Stage of operation
Date o | Date of Operation
Link type o | Linked Activity to Operation
Link Item Linked items
Share Share percentag
Symbol Additional symbols
Footnote Additional footnotes to record
\ o= optional /
¢ 2 AYéSNJj I )/Sé 2LJSNJ'(]7\2Y AYGE 0KS LINPAINI YZI Of

the scroll down menu in the operations coluorr b #

Select a particular operation and the area and cost will appear automatically in the other columns
deriving the information from the master database. Then select the appropriate timing, symbol and

any other notes that can be included for the particub@eration.

Linking Operations
To link a particular operation to a particular link type, simply click on the linking button at the top of

the pane to display the linking colum &=

With the linking column displayed, you are then able to select a paatitink to the operation by

GzaAy3 (KS ZONREf R2ey (O 8§ WiAy] G@LSsQ
Crop Area [ha sown]
Seeding [$/ seed]
Harvest [$/1]
Fertilizer [$/t All)
Fertilizer [$/t Select Fertilizer]
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lrfaz GKS WAyl AGSYQ aSOGA2y I LIWSEFNE sKAOK I RRa

harvest units. This option ot defaulted to grairso must be seleed in certain circumstances

Lirk. [tem
10.0 T Fertiliser (22 $5./T = $50

To unlink the operation simply click on the link button a
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Importance of Operations
It is important that the data entered in the operations section is accurate. All the data collected in

the operations section is summarised and calculated in the gross margins section. Therefore it is

important that theoperation data is correct in terms of costs.

The operations are also displayed in the cash flow, so it is important that the correct dates and
figures are entered into the operations section so that they are displayed in the correct month in the

cash flav projection table in the Adviser and Manager programs.

SUMMARY

Summary

Fertiliser rSprays ]’Operatior}s/Summarv rDiar\,.r rFDrecast rGrDss Margins rGeneraI rWater Ise Efficiency rRutatiun analyzer ]

The summary pane displays the summary of the operations and adjustments previously made in
each individual paddock. It shows the cost, area and quantity of the particulables over the
8SENY 9FOK 2F GKS LI NUGAOdzZ I NJ adzYYlF NBE RNRLA R2

Crnp ~ || This particular menu determines the variables that will be displayed in tl

summary display. These variables consist of Crop, variety, fertilizer,

Chemicals chemicals, and ggrations.
Qperations

(uantity || This particular menu determines the cost, quantity or area of the particu

variable at a particular time.

This menu determines what portion of the season will be displayed in th

summary.
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Show Months

The summary displayed can also be printed by simiftiting on the print buttor| &

DIARY

Diary

Fertilizer rSprag.-'s rOperatiu:uns rSummar):/wDiar';.f rFu:urecast rGru:uss Margins rGeneral r'l.-'-.l'ater sz Efficiency rRDtatiDn Analyzer ]

The diary pane allows for you to enter notes or data for particular dates in regards to the selected

paddock. It also allows for you to enter rainfall figures in for each day of the year.

There are three months ditgyed on the screen and can be scrolled through by pressing the arrow

keys located next to the two months on the edges.

Movember 2006 December 2006 January 2007

To enter a specific diary entry on a particular date, simply click on the date on the calendar and then

press the add note button kich will then bring up a section to write a particular entry.

Movember 2006
Mon Tue Wed Thu Fri Sat Sun

44 1 2 3 4 5
45l 7 & 9 10 11 12 Date Fain [mm] | D etails
46|13 14 15 16 17 19 18 Mov 05

47 |20 21 [zz] 23 24 26 »

45127 28 29 30 b*

To gain an overall summary of all the paddocks on the farm, click on the Farm Name or Block name
in the navigatio,JF yS YR (GKSyYy OKS®S@IRS|zummaryMode[#]| W{ dzY Y| NE

This should bring up all of the notes and data over a period of time for each of the paddocks in the
section below. To change the particular time frame of the Summmerge, click on the starting date
FYR GKSy Of Atdb] | From Sunday 1 January 2006 [ Q

This should change the date to the particular date currently selected on the calendar. Repeat the
same steps as above to get the end date by selecting the end of the time frame on the calendar and

iKS y LINB & aA )IT::. Sunday 31 December 2005 | oD

To obtain a printedversion of the summary, simply click on the print button located above the

notes. %
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Production

Fertliser Sprawys Operations Summary Diaky | Production | Gross Margins General “Waker Use EFficiency  Rotation &nalyzer

The production pane determines the expected prices and yields for the particular paddock
highlighted in the navigatiosection. To view ottr paddocks prices and yields, scroll through the
paddocks in the navigation pane. In this section you able to add additional harvest units like Wheat

grain and straw ect. The default settings are set to grain but can be adjusted by selecting the

productslink or adding another production unit| |praduct

b [Grain -
/ Table Layout Production (Price/Yields) \
Units Select Unit type i.eonne sect
Kg/Units Determine the number of Kg per Unit
Target Grade o | The target grade for the current crop selected
Pessimistic Price ($/t) Estimated Price at a Pessimistic view
Expected Price ($/t) Expected price to recedv
High Price ($/t) Estimated Price at a optimistic view
Pessimistic yield (T/ha) Estimated Yield at a Pessimistic view
Expected yield (T/ha) Expected Yield to receive
High yield (T/ha) Estimated Yield at a optimistic view
Retain (T) o | Amount d seed to retain from paddock
Estimated Harvest Date o | Estimated date of harvesting the particular paddock

\ o = optional /

At the bottom of the pane there is crop production forecast that includes the crop, variety and

Grade. This displays the crop production forecast in tonnes by the three different perspectives,

which include pessintig, expected and high.

Crop Production Forecast [Tonnes)
Crop Wariety Grade Pezs Exp High Retained
fafheat AFw Brookton a0 100 150 1]

The crop production forecast can be summarised by crop, variety and grade by selecting the various

diSpIays, Sumrmarise Crop Production by
) Crop ) Warieky @ Grade
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Gross Margins

Fertiliser rSprays rOperatic:ns rSummary rDiary rFDrecas/,VV iaross Margins rGeneral r'-.ﬁ.-'ater Iise Efficiency rFlu:utatinn Analyzer ]

The gross margins pane shows the gross margins of each individual paddock or over the whole farm
deperding on which is currently selected in the navigations pane.

DNR&a YIFINHAya OFly 06S @OAS6SR Ay
LI &G dzNBkINI T Ay3 LI RR2O]

Gtk yeé

AGa oSad G2 asStsSOd atl

the negative gross margin. In this situation income can be assigned to the livestock section. To

include the depreciation and interest accumulated, simply check the corresponding boxes at the top

Include Interest Cosk Include Depreciation

By checking the boxes for both the interesidadepreciation, the accumulated interest and
depreciation for the year are displayed in the gross margin. These contribute to the costs of the farm

but are generally absent from the gross margins as they are commonly fixed costs.

To Print the gross marg, simply click on the print button located at the top left of the pa

GENERAL

! General

Fertiliser I’Sprays rOperatiDns rSummar';.f rDiary rFu:urecast rGrDss Margir}s/General r'r.-'-.fater Ise Efficiency rRu:utatiu:un Analvzer ]

In the General Pane financial data is recorded so it can be incorporated within the program and the
report. There is also space available at the bottom of the pane tcaddidional notes for general

comments on the particular year. These notes display at the start of the report.

-

—:I Table Layout General

~

Opening Balance ($)

o | Opening Balance of the year

Working Account Interest Rate (%)

o | Current finanal interest rates

Estimated months in debt

0 | Months in debt estimate

Quick budget Chemical costs ($/ha)

Quick overall Chemical costs budget

o= optional
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i Water Use Efficiency

Fertiliser rSpra';.fs rOperatiu:uns rSummarv rDiar';.f rFu:urecast rGrcuss Margins rGenerQJ/VWater Ise Efficiency | Rotation Analveer

The water use efficiency pane calculates the total net water use efficiency of the particular paddock

highlighted in the avigationpane by using the French & Shultz equation.

The first step in this section is to set the water use efficiency crop parameters by clicking on the

button in the top left of the pang

This will bring up an additional window wieethe crop parameters can be entered for reference in

the calculation.

A typical crop parameter layout can be seen in the following table below. The crop parameters are
composed of the crops neproductive water (NPW) that consists of mm lost to evaporatio

leaching, ruroff etc during a normal year and a dry year. The harvest index represents the total
percentage of the crop biomass extracted at harvest and the root index represents the total

percentage of crop roots compared to entire crop.

MPW = Crop Mon-Produckive Waker

P - Harwvest Riook .
Crop Marmal NP - Index  Biomass B":'nlass C

£ram) ey (rnmn) (%) {5 (%)
Barley - Feed 100 a5 45 30 45
Barley - Malt 100 a0 40 a0 45
Canola 120 an 40 a0 45
Field Pea 110 32 30 =]
Lupin {albus) 110 35 30 43
Lupin {auguskifolius) 110 35 a0 43
Oats - Grain 100 a5 40 30 45
Dats - Grazing 100 a0 40 a0 45
Dats - Hay 100 a0 40 a0 45
Yetch 110 3o a0 45
Wheat - AH 110 =1 45 30 =]
Wheat - APH 110 an 45 30 43
Wheat - Ausk, Hard 110 an 45 a0 43
Wheat - Ausk, Hard 110 an a5 a0 43
Wheat - Livestock 110 an 45 30 43
Wheat - PH 110 an 45 a0 45

After thedata has been recorded, return the main screen by pressing ok. At the main screen the
Starting available Soil Moisture (SASM) and the Harvest available soil Moisture (HASM) can be

entered in the blue figures. Entering the figures in the top sections Isansat the default level.

Defaulk 5A5M O Default HASM EI
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Once these figures have been entered into the corresponding places, then the calculations are
compiled and displayed below using the French & Shultz Equation. To distinguish the differences

between dry conditions and norah conditions simply click on the scroll down menu above and

select the appropriate one|Mormal |,:

Marmal
Doy

*The total rainfall figures are calculated from the input of rain data into the rainfall section at the

top

Management rFarm rRDtatinns r.ﬁ.nalysls/wRainFall rCash Flo rLivestc:ck rInventcur\,-' rRepc:rts rMapping ]

ROTATIOMNALYSER

Rotation Analyzer

Fertilisar rSprag.-'s rOperatiDns rSummar';.-' rDiar';.f rFu:urecast rGruss [Margins rGeneraI rWater Uze EFFicienc}:/VRDtatiu:un Analyzer ]

The Rotatioranalyser provides a range of analysis that is dependent on the type of rotation that has
been established over the years on a particular paddock. The rotation analyser can display the

rotations for a 3 to 10 year time period, which can lofuated at the top of the pane| yazrs

The default tillage, burn and removal factors can also be changed at the top of the pane by entering

the figures in the spaces available.

Cefault Tilage Factor | 100 |Default Burn Fackor | 100 |Default Remowval Fackar

The Concept of Sustainability
Sustainability is the goal of most modern business®sit is increasing a much talked about

concept. Sustainable agriculture is generally quoted to integrate three main-gaalironmental

health, economic profitability, and social and economic equity (Feenstra et al. 1997). Measurement,
management andnanipulation of sustainability has been an elusive concept for the farm

practitioner due to the ofteHarge number and complexity of the measurements required to

produce a result from the more academic sustainability indices.
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The RotatiomAnalyser approach to sustainability management is proposed based on the premise
that at the most simplistic level: sustainability of farming is a function of efficiency of use of the most
limiting resource (generally water)is health (a function of carbon input) and profitability (gross
margin). Rotation Analyser requires input of a small number of commonly available paddock details
such as total crop rainfall, crop yield and value, and variable costs. These inputs ate cesedlate

ratios such as;:

1 Precipitation Use Efficiengyefficiency of conversion of rainfall into produgeising fallow
plus incrop rainfall received adjusts this ratio for the effectiveness of the enterprise owner
in storing and extracting soil wait. Decisions about tillage, weed control, nutrient use,
sowing date etc all impact on this ratio.

1 Carbon Conversion Efficiengefficiency of conversion of water into plant carbon to sustain
soil health

1 $ Precipitation Use Efficiengyhow effectively ranfall is turned into dollars

T Carbon Efficiency IndexGreenhouse gas is an issue that is starting to impact on the farm
sector. This ratio is derived from the soil carbon inputs and variable cost reflects the carbon
returned to the soil per unit if cartoconsumed, using the assumption that most of the
variable cost inputs are high carbon emitting during their production eg fertiliser and fuel.

1 Input Cost Efficiency effectiveness of using variable cost (energy) inputs.

1 Economic Efficienayefficiency wth which economic resources (variable costs) are used.

These ratios are then used to calculate and overall sustainability index to allow the comparison
between rotation plan for a paddock or between paddocks. They also play a vital role in providing
information about the strengths and weaknesses of individual crops in the rotation allowing
tradeoffs between areas such as profit and soil health to be made with some knowledge about the

scale and impact on the overall sustainability of the rotation.
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The Recommendations tab is locatedhie ManagementTah Recommendations are "stand alone™
and not linked directly to plan or actual@nce created and saved the paddock recommendation can
becopiedandi 3SR | a I2/NRE Gy awiS QI KS LI RR2016a&0 Ay
A recommendation report can include;

1 Single or multiple spray recommendations

1 Each recommendation can include any humber of paddocks

i Spray Recommendations

Fertiliser rSprays rOperations rSummary Diary | Production rGross Margins rGeneraI rWater Use Efficiency rRotation Analyzgr/wSpray Recommendaticns l

Recermmendations

b+ Create New | _f Edit Selected | ¥ Delete Selected | [ Copy To Actuals | Filter by Product:

Recommendation History
J30b Mumber [Date Created [Last Modified [Advice Type [Remarks
[ES [27/05/2010 8:38:45 [

1. ToQeatea new Spray &ommendationclick the > * Create New 1 ion A new
Recommendationwill be now be available in thRecommendation Historpanel.

2. ToHlit aSpray Rcommendationclick the _J Edit Selected 1y 11on. This will open the Spray
Recommendation Manager panel
*When editing a Spray Reccomendation please note that it wilawed to the paddocks
addedto the recommendation and not the paddock selected when created.

3. ToDeletea Spray Rcommendationclick the VA Delete Selected 1 110

4. ToCopy from Plan to Actualslick the L& Copy To Actuals 1y, it0n,

5. Enter a produchameinto the Filter by Productearch box to locate thBpray
Recommendation containing the product. (Use this feature to quickly sort through multiple
Recommendations and grodpem by product).
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/ Table Layout Spray Recommendations \

Recommendations :
b # Create New Create a new Spray Recommendatio
_J Edit Selected Open selected.recommendatlon in the Spray
Recommendation Manager panel.
PA Delete Selected Delete selected recommendation
(32 Copy To Actuals Copy selected recommendation to Actuals
Filter by Product: Filter recommendations by Product Type
Recommendation History :
|3ob Number | Enter Job Number for the recamendation
|Date Created | Date recommendation was Created
|Last Modified | Date recommendation was Last Modified
|Advice Type | Add Advice type eg phone, office, on farm, field inspectior

\ |Remarks Add Remarks eg with farmer/employee/owner /

Spray Recommendation Manager

- \\ Q)' ) Spray Recommendation Manager @ LIEK&J
Recommendations Report Notes Editor Settings
» Add Mix N oy
" Delete Mix ‘ V| Use Arable Area if available
Paddock ha Crop Detail Application Recommendation
Crop: Water Rate (L/ha): 60
Variety: Droplet Size:
Crop Stage: Application Method: Ground
Conditions: Rainfast (hrs):
UNDERSOWN Buffer Zone: No
days
WHP Grazing:
sk WHP Cutting:
WHP Harvest:
Plantback:
Total ha: Timing:
Resistance Status:
Comments:
»

1. ToAddanother Mix to the Recommendation click t ** AddMix  ytton.

2. ToDeletea Mix from the Recommendation click t " Delete Mix 1y iion.

3. ToSortthroughthe Mixes on your Recommendation click © ™ buttons to move the
mix up or down.

. |¥| Use Arable Area if available .
4. To use mailable Arable Aregersus boundary areansure box is

ticked
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f Table Layout Recommendations Tab
»= Add Mix Add Mix to recommendion
% Delete Mix Delete Mix from recommendation
- - Click arrows to Sort mixes
V| Use Arable Area if available Tick to use Arable Area if available

NG /

Add details to a Spray Recommendation

1. ToAddaPaddockio a Mixdouble click the blank space in the Paddock panel addop down
box will appear. Select the relevant paddock. You can add as many paddocks to a mix as you
like.

2. ToAddaCrop VarietyandCrop Stageloubleclick the blank space anddaop down boxwill
appear. Select the relevant entry.

3. ToAddConditions click the blank space nexiGonditionsto type a description e.g. actively
growing, 3 days after last frost, calm

4. ToAddanUnder sowncropor pasturedoubleclick the blank space in thénder sowrparel
andadrop down boxwill appear. Select the relant species

5. ToAddaDroplet Sizeclick the blank space in the Application panel amit@gp down boxwill
appear. Select the relevabBtroplet Sizee.g. Fine, Fine/Med, Medium, Course, Very Course

6. ToAddaTimingclick the blank space in the Application panel artigp down boxwill appear.
Select the relevantiming.

7. ToAddaProductclick the blank space in tHRecommendatiopanel anda drop down boxwill
appear. Select the relevant paddoclouXan add as many paddocks to a mix as you like.
Once a product has been added, the following fields will be populated from tstdvData

Base

Rainfast (hrs), WHP Grazing, Cutting, Harvest, Rate, Units, Reqd, Chemican@vscijve
Constituem (You can change any of these figures by double left clicking the figure).

8. ToAddaReason/Pestclick the blank space below andleop down boxwill appear. Select the
relevant Reason/Pest .

9. ToAddaGrowth Stage/Densityclick the blank spadeelowand type relevant details e.g. GS 31,
10/square metre

10. ToAdd a Resistance Statuslick the blank space below and type relevant detalil
11. ToAdd a Commentclick the blank space below and type relevant dstalil
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Table Layout Recommendations Tab

Spray Recommendation Manager:

Paddock ha ok
Sand Hil 206 Click drop down arrow to
; . Adda paddock
;Blod( 3 vi 11
Crop Detail
Crop: | Wheat APH v Click drop down arrow tg

Variety: EGA Eagle Rock APH/PBR
Crop Stage: Before seed set

Conditions: Calm

Add Grop Type, Variety,
Stage and Conditions

UNDERSOWN Click drop down arrow tg
: Lucerne/dover v Add Undersown Crop
Application
Water Rate (L/ha): 50
Droplet Size: Medium
Application Method: Ground
Rainfast (hrs): 6
Buffer Zone: No o
e Enter Application data
WHP Grazing: 7
WHP Cutting: 7
WHP Harvest: 7
Plantback: 0
Timing: ; Before planting v
Recommendation Rate | Units | Reqd. Click drop down arrow tg
Roundup CT - 1 L 217 Adda Chemical

Reason [ Pest

Click drop down arrow to

 Wild oats - Adda Reason / Pest
Growth Stage / Density Type a Growth Stage /
Before Seeding Density

Chemical Group

Displays Chemit&roup

Active Constituent
450g/L glyphosate (ipa)

Displays Active
Constituent

Resistance Status: Nil

Type Resistance Status

Comments:

Type Comments
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A large number of categories and items have been added to the Master data Base to enable quick
functionality of most drop down boxes in the Spray Recommendation feathmeupto-date

Master Data Base file is alwaggailableon the Back Paddock web site to ddaed.

Usersmayfind it easier to use¢he updated Master Data Base file and customisgher than addall

the new items so that the drop downs work smoothly.

Report Tab
—/ Recommendations Report Notes Editor Settings
-,j/ Print V| Title v| Client v| Days Valid v'| Time Stamp Footer | . . a — t{
‘ Save as PDF || [v| Job Number [v| Agronomist [v| Notes V| Page Numbers _ || [¥| Include Recording Sheet Qe
E—’aEmail PDF v!| Date v Product Summary v/ Signature Boxes |v| Footer ¥| Show Logo |5 ‘J J
Zoom| Fage

TheReportTaballows you toPrint or Saveas PDRyour Spray Recommendation. By editing the tick
boxes you are able to customise what appears in the repéou can alsadd and change the
position of a bgo and include &pray OperatoRecording Sheet with your report.

1. ToPrinta report click tie = Print button.

Save as PDF

2. ToSave as PDélick the™ button.

3. ToEmail PDRlick the& Email POF o
4. To toggle the various components of a report on or off, check/uncheck the relevant tick box.

. . V| Show L =
5. ToAddor change a Logim .bomp formatclick the awltoga ||

Logo on ooff check lincheck the tick box.

button. Totoggle a

6. To change the position of the Logo click ' ' buttons. (Note: clicking, | will
create a full pag&ogo).

7. TolncludeSpray OperatoRecording Sheatheck ncheck the tick boxthis form can only
be completed as a hard py.

&

8. ToZoomin or out andScrollthrough the pages of a report click tizsi: buttons.

Lo®
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/ Table Layout Report Tab \

=4 Print

Save as PDF Print, Save or Email Spray

£} Email PDF Recommendation Report
V| Title V| Client | Days Valid V| Time Stamp Footer
V| Job Number [v| Agronomist v/ Notes v/ Page Numbers Tick box to include Components in Spra
v/ Date v| Product Summary |V Signature Boxes |V Footer Recommendation Report

- — Top boxes position Logo Report
v showlogo |5 Tick box to show Logo in Report
Tick Folder to select Logo (bmp or jpg)

v Include Recording Sheet Tick box to include a Recording Sheet in
Report
® Click magnifying glass to zoom in or out

Q G

3 Click arrow to scroll through pages of
\ ; L_ Report /

The Notes Editor

Z3 % (@ | Arial 110 .~ Iﬁdent Sxiacmg Line Spacing -
‘ ||| E= etz |0 s | $=Before: Opt 3
u X, === =|z - Yz ‘
2 Bandait X s == =S Right 0 s | Y= Atter: Opt 2

The Notes Editor is used fadding notes, disclaimers alkey codes etc. tyour Spray
Recommendation ReporfThese notes will appear ithe footer of all recommendation pages.

It works lile any other standard text editor allowing you to adjust the font, size, indent and spacing
of the footer.

A few examples are:

1 Whilst every care is taken the preparatiorof these recommendations cannot accept
responsibility for unsatisfactory results. Many other factors beyond our control, either
before, at, or after application, can affect the efficacy of the recommended treatment. If in
doubt that conditions may have changed since these recommendations were made, you
should contactme. Manufacturers instructions should ALWAYS be read before
application. Treating weeds larger than stated on the laleht the growers risk. &ccept
no responsiltity for off label/off permit application.
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"READ THE LABEL BEFORE YOU BUY, USE PESTICIDES SAFELY". ANDAYSLREND
PRODUCT LABEL ADVIEERPECIALLY SPECIFIC APPLICATION INSTRUCTIONS. CHECK THE
STATUTORY BOX ON THE LABELS FOR "NO SPRANPANEIER REQUIREMENTS.

To the exént permitted by law | accepio responsibility to the Client and assumes no duty of care

to the Client in providing this recommendation schedule to the Client and any use or non use by the
Client of any statements, &ite, information, recommendations or suggestions in this
recommendation schedule.

The Client accepts this recommendati@port and uses it or does not use it at its own risk. tie

extent permitted by law accepto responsibility to and assumes notgwf care to any third party

(being any person or legal entity other than the Client) in relatiothi® recommendation report

This recommendation schedule is provided to the Client only and to no one else and for no other
purpose. Any third party (lbleg any legal entity other than the Client) uses or does not use and

relies ypon this recommendation reporr any part thereof at its own risk.

9 Please carefully read the label information before commencing any treatment program.
Whilst all care is taken in the provision of these recommendations, environmental, seasonal
and other conditions can affect the performance of the treatment. Accordingly | will not be
liable in any way for the failure of the treatment where seasonal conditions have changed
since the date of this plan. If chemicals are not used according to the label direction, you do
so entirely at your own discretion and risk.

Water conditioners e.g. Liase; 100, Ammonium Sulphate

WETTABLE POWDERS

Granules e.g. Atrazine, Logran etc

Flowables ay. Diuron & Simazine

EC formulations e.g. Trifluralithese makes the water turn milky
Aqueous solutions e.g. Roundup, Sprayseed

=A =4 =8 =8 =4 =

=

SPRAY OILS THEN WERS E.G. BS1000, BRE

Ensure that the tank is half full before you start adding chemicals. Ensuraghation is
operating before chemicals are added and allow each chemical to be thoroughly mixed
before adding the chemical. Finally, add the wetter as late as possible to minimize foaming.

=

Settings Tab

Recommendations Report Notes Editor Settings

The Settings Tab is used to adjust and entéadl settings that are displayed in the Spray
Recommendation Report. Itis used to alter the Font size and type, and various details that you
would like displayed on reports.

Please notelent details are added outside the repdnt Tools/ Options/ Glint Details.

Using large font sizes can cause the report to display incorrectly, the table betbmes the default
Settingif you need to reset.

Adviser / Manager User Guidepage50




ED
EE];E/

BACK PADDOCK

Table Layout Settings Tab

E Recommendation Fonts

Heading Font Arial; 8pt; bold ch Font si dt ¢
Client/Agro Details Font Arial; 8pt ?nge on _Slze and type (;)f

: . various headings presented in the
Recommendaticn Font Arial; 8pt report
Valid Statement Font Arial; 8pt port.

Text Spacing (mm)

0

|E Page Title
Title Text
mm from top
mm from left
Justify Page Title
Title Font

Field Service Recommendation Form Add a title to reports and adjust

0 Font size, type and position.
50 *Please notelarge Font sizes may/
Left cause reports to display incorrectl)

Arial; 8pt; bold

|E Page Footer

Add Footer to reports and adjust
Font sze and type.

Footer Text Back Paddock . .
Eocter Fatt Arial: 8pt Please notelarge_ Font sizes may
cause reports to display incorrect)
B Agronomist
Title Text Back Paddock
Name John Citzen
Branch Cleveland Add Agronomist name and contac
Phone 1800 557 166 details.
Mobile 0427 557 166
Fax 07 3821 3544

CEET I support@backpaddock.com.au

El Notes

Add a border and adjust

Email Default Text

Notes Border v background colour to Notes
Notes Background Colour - 0;141; 41 section.
R - Enter default information for

Please find attached your spray recommendation.

emails and pdf.

B3 Job Number

Job Number Title Job Number: Edit the Jb Number of Spray
Job Number Prefix recommendation_
Job Number Start Number 39

Bl Other Details
Client/Customer Title Client

Valid Statement

Unless otherwise stated, the treatment recommendation should be applied within 7 days by an industry accredited applicator E nte r oth e r d eta| IS
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5.3 FARM SECTION

| MEII'IEII;EI'I'IEI'/IVVFEIFI'I'I ar:-tatin:nns r.ﬂ.nal';.fsis rRainFaII rCash Fla rLivestn:n:k rInventn:nr';.f rFiepn:-rts rMapping ]

As previously mentioned in Chapter &etting up the Farm, the farm section alloyou to create,

adjust and arrange the paddocks on the farm. This is done using the buttons below the Farm tab.

—:I Table Layout Farm

- Move selected paddock up or down
b Create a new paddock
e Insert a new paddock above current selected
KA Delete current paddock
& Print this page
1! I NN} y3S LI RR2014a It LKFEoSGAOL t {
Eg) Copy plans to actuals
= Displays rainfall sites column
Cuick Entry Quick entry mode for paddock entry
Displays multfarm options (Create, Delete, Rearrange farm blocks
Mulki-Farm
Home Farm = | Select a different Farm Block
Map Setup = Displays the 'boundary editing' window.

Paddock Boundariegot included in Lite versions)
One of the major functions of the Farm Section is thetghid map out the specific paddock

boundaries on a Gemeferenced Aerial Photo map. This tool is useful in determining specific land

areas and a detailed outlay of the farm/s. To enter the mapugesimply click on the scroll down

menu on the map setip tab and select boundaries. Map 5Etupq
r= Boundaries
Map Setup = [ | === >
Ll arable

This will then bring up the Advisor boundary tool where you are able to create and edit particular

paddock boundaries.

*The Steps involved to create paddock boundary maps can be seen in the Mapping section,

Chapterc 6
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Management rFary/wRDtatiDns r.ﬁ.nalysis rRainFaII rCash Flo rLivestu:uck rInventDry rRepDrts rMapping ]

The Rotations View provides an alternative data presentataine Managemen¥iew as it can
present up to 10 years of crop type / variety data at one time. This is useful when you need to see
what has leen grown in paddocks in previous years while planning rotations for the present and

future years.

Area Summary

The Rotations View also has an area summary table that displays a tally of total area for different
crop types and categoriesprresponding to the years displayed in the rotation table. This can be
useful when planning the balance of production or when for example percentages are required for

the spread of Cereal, Broadleaf and pasture.

AREA SUMMARY [ha] - Home Farm
Category | Crop | 2004 | 2005 | 2006 | 2007 | 2008

There are a few options that allow thable to expand further that consist of adding varieties,sub
totals and percentages. These options can be included in the table by checking the boxes above the

table.

o NMarieties o Sub-Totale 3 Percentages

The bottom table represents the paddocks and the corresponding crops to the partyaar
displayed at the top. To expand the columns and display the variety as well, ddigklen the top
2T (GKS O2fdzvy 2y GKS @SIFNI 2NJ W/ NRLIQ® ¢KAA &Kz2

and variety of that year.
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Management: rFarm rRDtatinr}s/ analysis rRainFaII rCash Flo rLivestDck rInventnry' rRepu:urts I’Mapping ]

The analysis section in advisor, analyses the felathe particular year displayed. Each paddock is
displayed with an analysis of the crop, variety, price, production, yield, income, total costs, gross
margins and cost percentage inconSel OK 2F (KSaS @I NAIFof SaQFNB il

section of advisor where the data was entered eatrlier.

There are a number of views that can be used to view the paddock analysis. The sogeaitder
allows yu to view the order of paddocks via their productiveness. The table can also be changed to

view a pessimistic, expected or optimistic view of the production and prices of the year.
By choosing between Ascending and Descending sort artkclicking on a particular
column heading on the table, the layout will change to display the particular column in
ascending/descending order in relation to the columns value. The Paddock field sort

alternates between alphabetical and user definghen repeating the heading click.

Sort Order [Click Column Heading ta Sort]
Ascending # Descending

T

t

or

Analysis - 2006 Plan | | |

FPaddock | ha |El0p |\-"ariet_l,J | Frice | Frod. | “rield | Income |T0t. Costs| Gk argin |I52§fe

Check this box to display income, total cost and gross margins in
$/ha

Check this box to include a column displaying the interest for eacl

[nizlude [nterest

paddock

Check this box to breakdown and display the costs in seedsihy,

S how Cost Ereakdown fertilisers, chemicals, adjuvant and operations.

Use the scroll down menu to choose between an expected,

Price

pessimistic and high price received.
Production Use the scroll down menu to choose between an expected,

pessimistic and high production levels.

folealics Choose to display the bottom totals as an average or total and che

* pyerage Total
Weight Averages by ha

the box to weight the averages by hectares.

Adviser / Manager User Guidepage54




E
EEIZ?/

Exporting Table BACK PADDOCK

¢tKS DNR&&a YINBAY GFLo6tS Oy ©6S SELRNISR (G2 Fy2i{iKE

table can be displayed in®@K LINR IN} Y& & SEOSt 2NJt5C Si0Oo ¢
GFrof$ G2 OfEREpBAKNRAR sHAfiaytt2s &2dz G2 GKSY ahl

select paste via the Edit>Paste function.

5.6 RAINFALL

Management rFarm ar:-tatin:nns r.ﬂ.nal';.fsijs/VRainFall rCash Floa rLivestn:n:k rInventn:nr';.f rFiepn:nrts rMapping ]

The rainfall section allows yda record rainfall levels at any date of the year. This section is mainly
displayed in yearly view with the months running across the top of the table and the dates running
down the side of the table. The rainfall section also has a navigaiizaiow that allows you to

quickly identify months and dates for future references.

To add or choose between different rain gauges, use the functions at the top of the navigation

window.

Click on this function to bring up andow to add new

rain gauges and adjust there location by entering th

Northing and Easting eardinates

Click on this function to import rainfall data from

another specific source

4

Use this scroll down menu to choose between the

Rain Gauge - | different rain gaugesn the farm

Allocating Rainfall Gauges to Paddocks

In order to designate specific rain gauges to various paddocks, the number of rain gauges must first

be compiled in the rainfall section by clicking on the add butl [

Once the number of rainfall gaugkas been compiled, enter the main Farm tab at the top of the
page where the paddock boundaries are create /Ff'm

Once in the Farm section simply click on the rainfall gauge button at the top of the window to

display the rainfall gauge column [g]

R

ISy
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The rain guges can then be allocated to particular paddocks by selecting the scroll down menu in

Rain Site
Fain Gaugdi
F ain Gauge 1
Rain Gauge 2
Rain Gauge 3
Fain Gauge 4
Rain Gauge & &

the column and selecting the appropriate rain gauge for the s

Rainfall views and Displays
To change the view of the table, scroll down to the bottom of the ratiog window and click on

YWY2YGKQ 2N WeSIND @ASs (2 RSUGSNNAYS 6KAOK @AS
Month View

Year View

To display the rainfall chart with the current rainfall figures for the year, check box at the bottom of
the navigatiorwindow to display the chart next to the rainfall table. The Deciles can also be

displayed in the graph by checking the box underneath the rainfall chart box.

Show Rainfall Chart
Show Deciles

The arrows located in the navigatisindow allow you to shuffle tlwugh the years in by 1 and 5
lots. Clicking on the single arrow will change the calendar either forward or backwards a year and
Ot AO1AYy3 2y (KS R2dzofS FINNBg gAff NBadzZd Ay |

in the calendar returimg to the present day of the current year.

(Today) (<< ] < J [ = ] =]

F Historical rainfall datais available from Bk Paddock Software. Licenced users just need to phot

the Help Desk ott800 557 16@®r email tosupport@backpaddock.com.awuith their request.

1. You must clearly nominate the nearest open Bureau of Meikxgy (BOM) recording station tc
your farmg often post offices, research stations and some farms. Best to nominate, if know
the BOM station name or number.

2. If not known then simply nominate nearest town with a backup town close by and the parti
Stae.

3. Data should then be emailed back to you via Back Paddock Software with instructions on |

down load the file.

To import the downloaded historical rainfall data file into adviser, start in the rainfall section of

w

program and simply click dn K S WA Y LJ: % LITHds will briigiup gh additional window, wher:

you are able to import the particular data from the saved location you designated when

R26yt2lRAY3 GKS TAES 0 O0tA01Ay3I 2y (GKS ah
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5.7 CASH FLOWOT INCLUDED INEIVERSIONS)

IManagement rFarm rFlcutatiDns r.ﬁ.nalysis rRainF-;IJ/FCaSh Flo rLivestnck rInventnry rFlepcurts rr'-’lapping ]

¢tKS OFrakK Ft2g aSO0lA2y RAaLIIFIeéa (GKS OdaNNByid &S|
expenditures, balance and Cash flow. This section derivegatsnation from other parts of advisor

and is mainly used as a reference to the cash flow over the months of the year.

Note: Caution should be taken when interpreting this section. It is not meant to be a comprehensive

cash flow.

It is important that eah of the income or expenditure aspects of the cash flow have a designated
date in relevance to their activity date. The dates are designated in the corresponding sections in the

management tab under particular panes, like the fertiliser and chemicals.

Note: Please be aware of the date source and do not confuse activity date and purchase date.

KF The )

areas still have undesignated dates. If particular

6No Dated column can he

crop expenditure displays ¢
be in regards to an undesignated fertiliser used on

the crop.

= j

Exporting Table

¢tKS /1aK cf2g GlLoftS Oty 68 SELRNISR (2 y230KS$
can be displayed in such programs as EXieF or Word. To copy the table, click on the top left

hand square and drag down to the bottom right hand square so that al the square are highlighted in
6t dzS® ¢KSYy NRIKG Y2dzas Of A O] EdtiCopiGntedniadother O 2 LIB ¢
program simply right mouse click on the empty screen and select paste or follow the commands,

Edit>Paste
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5.8 LIVESTOCK

Management rFarm rFlu:utaticuns r.ﬁ.nalysis rFlainFaII rCash FI:::yJ/w Livestock rInventnry rRepDrts rr'-“lapping ]

The livestock section allows for you to adjust the groups of livestock located on the farm and which
paddock they are corretad too. The first section allows you to classify the specific stock group and

then the later sections classify the stock class and then the related income and expenditure.

Stock Groups
The livestock section allows you to include livestock groups anskslasto the program that are

currently run on the farm. The first step in this section is to define the particular stock groups that

are on the farm i.e. Sheep or Cattle. Click the add group button at the top of the wif #* .

*This section applies to alegrs. Yearly data is altered in the below sections (Mobs)

This will then provide a scroll down menu in the type column that will allow you to choose the

particular Group type on the Far| |Tupe

b |
Sheep

Cattle

After you have determined the particular group type, you are ablgive that group a particular

group name (optional) and also add any particular notes.

Group Mame [optional] Motes

Define Mobs
After the Group type is determined Mobs section is then available to further define the selected

(3

group type. Click on the add button to enter a new &tatass for the grouy

Once you have added a stock class you are able to access the scroll down menu and choose a

[ 2 o
Ewes [diy]

Ewesz Hoggets

R amz [poung]

Wiethers

Wiether Hogoets

Ewes [mated)

specific class for the group. \\Stuck Class

Once the stock class has been entered a description, opening number, DSE/hd, Value ($/hd) and
notes can beadjusted and entered along side the class.
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Table 2 MOBS - Define Mobsz for Selected Group in Table T [Current vear Only)
Stock, Clazs Dezcription [eg Tag Colour] Open Mumber DSE/hd | Walue [($4hd] [Motes

There can be a number of stock classes added to a particular group that could consist of ewes and

weaners or Steers and Heifers etc.

*The particular year can be adjusted by selecting the arrows locdiedeatable 2/ % * 2006

Once the stock classes have been identified in the group type, the costs, income, gross margins and
Paddock allocation can be compiled at the bottom of the page. This section has the four sections

displayed in tabs along the top part ofelbottom pane.

Costs | Income  @ross Margin Paddock allocation

Costs
The costs section indicates the particular costs associated with the current selected Mob. Using the

scroll down menu you are able to choose from a list of costs and then determine the units, $/unit,

units/hd, hd, date and notes thatre associated with the particular cost.

[ [Description | Uritz | $nit | Unite/hd [ hd  [Date [Motes

Income
The income section indicates the particular income associated with the current selected Mob. Using

the scroll down menu you are able to choose from a list of income types and determine the units,
Low ($/unts), Expected ($/units), High ($/units), low (units/hd), expected (units/hd), high (units/hd),

hd, Date and Notes that are associated with the particular income type.

Lo Ewpected High Loy Eupected High hd

etz Iy e Urits | oilini) | $/Unit | ($/Uni) | [Uritsthd] | Uritsshd | (Uritséhd] Lz Helize

Gross Margin
The gross margin section provides an overview of the particular groggmador the currently

selected stock class. To include certain features like the interest, livestock capital costs and

depreciation, simply check the boxes above the gross margin display.

Include Inkerest Include Livestock Capital Costs Include Depreciation
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Paddock Allocation
The paddock allocation section allowsuyto allocate particular paddocks to the currently selected

livestock The current stock groups selected will be designated the paddock in the paddock

allocation section. In the left hand window, a list of the farms and paddocks*'re

displayed and can bexpanded and retracted by selecting the plus/minus button next to the names.
Once a particular paddock is selected, click on the add button which should then make the paddock
appear in the paddock column. The area is displayed in the adjacent columreanto this column

is a place to write notes corresponding to the particular paddock and livestock.

All paddocks that are grazed, irrespective if pasture or crop, must be ticked in the Management zone
under the flag section as a pasture otherwise staidkbe unable to be allocated to that particular

paddock.

FPasture

> ¥

5.9 INVENTORY

Management rFarm ar:-tatin:nns r.ﬁ.nal';.-'sis rRainFaII rCash Fla ]’FLi'«esI:n:u:};/w Irneentary rRepn:nrts rMapping ]

The inventory section allows you to adjust certain inventory items that are in possession of the farm.
Ideally this section refers to the stored available chemicads éine on the farm. The inventory
section also lists the people associated with the farm in terms of owners, employees, contractors

etc. To add a new chemical, simply click pnthe add button located in the Products window.
X3

Atfter clicking this button, a newventory column will appear in the right hand side window that will

allow you to select a particular chemical brand and lists information on the particular chemical.

The main part in this section is to use the scroll down menu and select the partbelaical.

Chermical m

Achieve Wi
Activatar
Activail

Adigor

Affirity 400 DF
Al

Alozca Gp 5
Arnine 500
Armine 525
Arnmo

Adviser / Manager User Guidepage60




-

BACK PADDOCK

There is also a list of other information that is optional to enter for the particular chemical that

consists of information like, purchase date, pack size, cost, notes etc.

To add people in the inventory section, simply click on thepgbe tab at the bottom of the left pane.

FﬁW People

This will bring up a new pane on the right hand side that allows you to add new people by selecting
the add button and then entering information like their name, qualifications and notes in the

designated areas.

Management || Farm || Rotations || Analysis | Rainfall | Cash Flow || Livestock | Inventory | Reports || Mapping

People b+ WK
Mame Qualifications / Courses Completed Motes
B | Aerial Contractor-Skyspray |Chemical User Training Course 2006 |2IIIEI-5
Karen Woods |viticulture Pest Seminar [2008
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5.10 REPORTS
Management rFarm ar:-tatin:nns r.ﬁ.nal';.-'sis rRainFaII rCash Flo rLivesI:n:u:k rII'I'-."EI'Itl:IM Reports | Mapping

The Report section collectively acquires all the summaries and assumptions derived through the

program and display them in report format for printing and viewing. This report is displayed as
Wt DFYKFG A& RSNAGSR F2NJ I LI NIOAOdz F NJ @8SEFNJ YR
throughout the year.

Note: All prices stated in the report are GST exclusive and a guide only.

There are a number of particular reports thain be displayed via the report library, located in the
top left pane. These reports consist of the full repgeneral or general link mode, Share farming,

livestock, chemical history, crop input, paddock report, spray program and wheat competitions.

= %ﬂ Reports
= LA: Full Report
i General
i[5 General (Link Mode)
= % Share Farming
iY General - Land Halder
iY General - Share Farmer
Livestock
Chemical Group History
Crop Input Report
Paddock Report
Spray Program Report
3 Wheat Competitions Report

i o o 6

In each of these reports, there are different sections that are then displayed in the report navigator,
below the report library. This Report navigator allows for quick access to the certain parts of the

report, which are then displayed the main window on the right.

Fepart Mavigator e

Cover Page

Disclaimer

Rotations

Area Surnrmary

Seed Summary

Fertiliser Surnmarsy

Chemical Surnmary

Cperations Surmmary

Cosk Surnrnary

Gross Margin Summary
+- Paddock Summaries

Table of Contents
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To adjust the setip of the main report that is displayed in the main window to the right, click on the

setup button located above the window ggsetun

This then brings up the sefp window where adjustments to the repaddyout and display can be

made. To include and exclude particular parts of the report simply check or uncheck the boxes in the

left hand window. Intraductian

Ratations

Input S urimaries
Econarics
[]Images

+- [v] Paddack Details
+-[v] Headers

+- [v] Foaters

Index
[] Override Default Page Marging

o e B e

Adding Footer & Headings to Report
To include footers & headings to the report, simply expand the Headwatd-ooters section by

clicking on the expand button next to the nam#.

With these sections expanded there are a number of other details that can be included into the
report. These consist of: General notes, file name, farm name, logo, page numberandat

prepared by. To adjust the settings of these particular aspects, simply click on a particular one and
then an editing section should appear for some in the window to the right, complete the additions

and select ok.

Adding Logdnot included in Managr versions)
To include a logo on the report in sep expand Headers, select logo and browse for the particular

file. Then select OK. The logo should be a bmp file and approximately 185 X 160 pixels.

Paddock Order and Arrangement
Paddock Pagination arrgas the particular setup of the pages in the report. The option to group

paddocks by Farm or crop type can be done through the scroll down menu. Other options consist of
compiling the report so that each paddock is on a new page or is continuous; keeplithocs

together, thumb tags, subtotals and underling section headings.

Paddock Pagination

Group Paddocks By [(Farm 1= |

# Mew Page Per Faddock.
() Continuous
W' Keep Paddocks Together
W Thumb Tags
W' Subtotalz
W Undeiline Section Headings
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Font adjustments to Report
The report font and font size can also be adjusted at the bottom of the window by using the

designated scroll down menus.

Repart Font: Adjust Font Size:

T Times New Foman -

In the main reports windowthere are a number of tools associated with displaying the report on

the screen or for printing purposes.

Refresh the current page

Search the Report for a specific section

Export report¢ save as a PDF, WordBxcel document

| B 22|68

Print Report

| W41 | » » || | Shuffle through Pages

100 - Al - | | Page displag Page width / whole page / zoom

Uses of the General Report
The report is essentially the whole programs management decisigptagled in an easily

referenced and formatted guide for users to clearly see objectives and decisions made within the
program for future use. The report can be an extremely useful guide for rotation analysis and
planning, investigating costs and expendés, timetable of operations, submissions for finance,

benchmarking and more.

Rotation Summary
The rotation summary of the report helps to clearly identify the paddocks rotations over the

previous years. Helps to providegaide for the current years rotation to be used and also to analyse

YSEG &SI NR& ONRLI NRGFGAZ2Y D
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Area Summary

The area summary of the report provides a whole farm overview of the total amount of crops
currently grown. This can be uséfo analysing output levels and planning sales and storage for the
current year.

Variables Summary

In this particular section of the report, the variables are summarised for the current year. These
variables consist of the fertiliser, emicals and operations. Each of these variables are summarised
by there particular product or operation, area allocated, average $/ha and total. These summaries
help to identify all the variable costs associated with growing the particular crops for thentu

year. The cost by crop is displayed at the bottom of the summaries and displays the crops in
association with their variable cost.

Costsby Crop Table and Graph

This section summarises the broad cost groups by crop type and id wéefh planning farming
requirements and identifying cost areas that could be re visited. The same information can be
represented in a graphical form by selecting cost chart tab beneath the crop costs tab in reports set

up.

Gross Margin Summaryy Crop

This particular section of the report looks at the particular gross margins of the crops in relation to
pessimistic, expected and optimistic prices and production levels. This section is ideal for identifying
the potential gross margins perop dependent on the type of season. This allows for an analysis of
management decisions that can be initiated if the season is better or worse than expected.

Paddock Summary

The paddock summary section mainly displays the crop and sexiaed costs and operations that
are devised for the year. This section is the main section of the report as it outlines each individual
paddocks variables and their timing of application. This provides a useful guide for advisers and
farmers and allow$or them to analyse and plan operations and applications that are needed in each
individual paddock. In the report seip tab tick off the economic tabs and Paddock details input

total tab and an operations report can be created and is useful for farmevsi contactors.
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Actuals
l'a YSYGA2ySR Ay GKS LINB@A2dza OKIF LJASNEXZ GKS LINE IN
section allows consultants and managers to plan certain events and operations prior to their

execution. Plans are useful intdemining the operations and costs that are associated

for the farm in that year and provides an outline for others to operate from. Once the actual plan
KFrda 6SSy SESOQOdziSR Ad Oly GKSy 6S NBO2NRSR I a y
The reportcan be changed between plans and actuals so that they display the current plan of

operations for the year or the actual operations and procedures executed throughout the year.

= Flan |-C= Ackuals
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Chapter 6 Mapping(notincluded in Lite veisns)

Management rFarm rRl:ul:atil:uns r.ﬁ.nalysis rRainFaII rCash Flo rLivestl:uck ]’FImnEerﬂ:-:nryf rRepDrI;sfMapping L

INTRODUCTION TO MARB

This chapter will provide you with a general overview of how to go about using Back Paddock
Mapping, it outlines the basic steps involved in setting up a farm map in Back Paddock
Software. After completing this chapter yauill be able to:

Obtain an image of your farm

Load your farm image into Back Paddock Software

Add paddock boundaries (arable and ranable) to your farm map
Add crop details to each paddock layer on your farm map

2008 Varieties f Crop Plan

=A =4 =4 =4 =9

Crop Type 2008 Plan

You . sareymat ed. See the

Cancla
be I o Ley Pasture

il Lupin (augustiolius)
Medic Horse
Qats grazing

il Oats hay
Pea

‘ Subclover

il Vetch

il Wheat AH

il Wheat APW

Crop Variety 2008 Plan

] 44C73 1T / Gaucho PBR BL-S

.l Belara PER

A Calingiri

‘ Excell Blue/PBR

A Geraldton

il G'acius PEREPR
Graza 68 / PBR

‘ Haymaker Plus PBR

gl InVigor

gl Kasoa Dun/EPR

.| Paraggio Barre!

‘ Schooner Malt/Public

gl zrren L Lignin

m.oo . n

Adviser / Manager User Guidepage67




E
EEIZ?/

BACK PADDOCK

.FO1 tI RR2O71 Q& aX brtharéstified geGnetficaltiziokréctedisS that distances
shown are uniform and can be measured like a nasgsjal photo with

known control points. Once loaded Back Paddock formats the image combining the visual
characteristics of a photograph withélgeometric qualities of a map, geo

referencing the image and resulting in a spatially accurate image to scale with correct
coordinates. This image eliminates distortions caused by camera angle and the altitude of
landforms. The image is generally toogarto email and is supplied on a CD and is usually a JPG
or BMP file type.

An aerial photo image is usually obtained by various aerial photo companies for a fee, these
LIK2G2a FNB KAIK ljdzZrfAGe RAIAGEHE AYHng&a oA GK
FSNAFE LIK2G2 FNBY F LIAR LINPGARSNEOD® | 245SOSN
an image of your farm, one of these options been Google Earth.

Google Earth can be utilized to obtain an image of your farm along with the appropriate co
ordinates. The process for obtaining an image from Google Earth is outlined in this user guide
6aS8SS aholdlAYyAy3 'y |SNAIf LK2G2 dzaAy3d D223t S
guality and accuracy we recommend a paid aerial photo provider.

OBTAINING AN AERIRHOTO FROM A PAID@ARDER

New South Wales

NSW Department of Land8h 02 6332 8123, Fax 02 6332 8299

Locate and purchase the image on the webhdfp://www.lands.nsw.gov.au/airview#Spatial
search>select map>place your

order>enter customer details>submit order>print order, complete payment details and in the
ALISOAlLT AyadNHzOGA2ya &Ll OS AYRAOFGS GKFG &2dz
the number above.

For acuracy and to avoid a spatial search on the web fax indicate the Parish, Lot and DP numbers of
the property, which are usually on a Local Government rates notice and ask for a quote.

Typical image prices range from $15400.

Victoria

Qasco VIC Imageh03 9682 3330, Fax 03 9682 3335 Ewmhigital@gasco.com.au

Firstly locate the property at Vic Land web site,

http://www.la nd.vic.gov.au/land/Icnic2.nsf/[Home+Page/Land+Channel~Home-PPage
open>Property reports>agree to terms and conditions>search for the property>print

Then draw the property boundary on the printed map and fax the map, Parish, Lot and DP numbers
to Qasco fom quote for a orthorectified image. Prices will range from $3800
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Western Australia

Landgateoffers orthorectified digital aerial photographic images at varying resolutions. These
images cover a large portion of Western Australia.

View, purchase ahdownload images online at SkyView WA (just select this link) or log onto
www.landgate.wa.gov.au/corporate.nsfaerial imagery > aerial photography > orthorectified digital
images > Skyview WAGo. Print out the handy hints and follow the directions.

SkyView WA displays digital aerial imagery for purchadamenUsing SkyView WA you can find your
area of interest on a map, view the imagery and then purchasknenall at the click of a mouse

You can order an ECW image orRXDM. ECW format is a more complex compression format
regularly used by mapping professionals, which allows compression of veriekigjhtion

(definition) imagery. ECW images are geferenced already.

Contact detailsPh 08 9273 7555 or Emaihles@Ilandgate.wa.gov.au

South Australia, Queensland, Northern Territory and Tasmania

Emailsupport@backpaddock.com.dar each lan title required; state the Parish, Lot and DP
numbers which are usually stated on all rate notices.
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HOW TO ID A PROPERIY GOOGLE EARTH FORGH
RESOLUTION IMAGE &RD

Please read the below instructions for details on how to fIbogerty on Google Earth for a high
resolution image order.

1. Enter the location of where the property is into the search box as shown below, for example
we have used the town of Hillston in NSW.

2. After entering the name click tI‘.L&J button to begin the search.

3. The location entered in the search box will shortly be displayed on screen, see below.

8 = Primary Datsbase

# Mg Geographe web
= rosss

» DI 20 Budngs
8 street View

# P Borders snd Labets
O reme

# [ 38 weather

- Djo«av

'DOMAW"S!

® 5] ¥ piaces of reerest

# DD more
[ seeran

M| % | P&

rallston NSW, Australia

Google

Q'Y 90AM
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assist you, they have been circled in red in the below image.

= Google farth

Fle ER View Tols A Hep

al 0oa&ag

# P Borders s Labels
D‘ Trattc

o I8 weatrer

# Clge Gatery

+ Domn-mx
o 51 I paces of rterest

o 10D more

E}hv-\

4. Zoom in and find your farm area as shown below. Use the directional and zoom buttons to

=

BACK PADDOCK

Google
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5. Once® dzNJ T I N¥Y |

below.

= Google Farth

v

= |2 & Primary Databose

# M g ceograpncvwen
[ mm mosas

+ LI 50 Buldngs
8 sveetvew

# [P boroers snaLavets
9§ nese

# 58 vestrer

# Clde Ontery

# [ @ Goos Awsreress

# [ P pces of rterest

# O30 more
Ehlm

7 start = Google Larth

NSl Aa

=

BACK PADDOCK

Cooglc

1 50 ke
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6. The New Polygon window is nhow displayed on screen, move thiiqggoof the New Polygon
window so your farm is still visible.

7. Enter the name of your farm in the Name box.

8. Configure the Area Colour to be Outlined as shown below.

9. Now you can draw around your farm image, leave some space outside of the property.

= Google Farth

Lres

coer. [] vaan (10 2 opacty 10

Aren
Color: [ Outines v facty. 1]

=]
L]
\A
= & Primeey Database
# [ g Geograprec v
[ rosds
+ Dﬁ 30 Buldngs

8 sveetvew
# (AP Dorcers andLabels
D' Trattc
# [ 28 veestrer
& Clde oatery
# D)@ GeosAwweness
# (5] P pces of reerest
# 1D woee
@hvn

Coogk‘

yo a

‘4 start & Google Exth
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10. See below for an example of correctly drawing around the property.

= Google tarth

v s
= (%5 Primary Databaze
# (@2 ceoyagnc e
[ mm roads
# D) 20 8udng:
8 sreetview
& [P porcers andd Lavels
CI§ maese
# 38 veesther
% Clde Gatery
¥ D@ cxonawwreness
# (5] F piaces of rterest
@ O vore

(7] weran

1 start R Goode Larth

11. After drawing around th property click the OK button on the New Polygon window.
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12. The name chosen in the New Polygon window will now appear in the Places panel as shown

below.
= Google Farth
Fle Et View Tools Add Heb
¥ Search
Fy® | FindBusnesses | Drectons
Fyt0eg 37 25 MEN 122055
Hbston v P

¥ Places A8 ot
= [E o wyPiaces
# DD sarteeang

r~ Y EETITET O

P Sdion hattnw: 84 $hirt the toxs
(4] Lanctian Fpeeie
@ ermowwyrm AN %
et ]
Copry
Detete

Omm rosss
+ CIQ) % eutdrg:
O 8 sreet vew
¢ P Boeders sndLaveis
0§ name
# )38 westrer
@ Ode ostery
. Co Global Awareness
# [5) P pusces of rterest
#® O voce
[ wrran

'J start £ Googe Laet

13. Righ mouse click on the name and choose Save Place As.
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14. Choose a name for the file and select where you would like to save it, see below.

Saverc | L) Wy Documerts
(Mg M
_.b Zimy Pctures
My Recent
Documents
Dedhtop
=
My Documents
My Conguter
.i
My Network  File nama: m
Places
Save &5 e [Kme )

W
= 5] Prinary Database
+ @ W Geograpre \Web

Clmm rosas

+ D 0 0udng:
18 sweet view

* V1P Bocders and Labels
O § matse

# D158 vesther

# Odr Gotery

+ Co Goba Awareness

% [8) F paces of rterent

& O more

[¥) serran
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15. Attachthis file to an email message and sendidate @backpaddock.com.au

‘ Coogln Earth

@) Pt thes fle to the Web
£ Tmal this fils Subiecti Emalng: Lauchian Fam's
X Delete this fle Actach: Pmnm‘s borz (513 bytes)

The message is ready to be sent with the followang file or
bk astachments
Lauchlan Farm's

Note: To protect agamnst computer wruses, e-madl
programs may prevent sending or recervng certam types

|

-

- -

gatsDile

;gewaA
2

OoOROODRS |

o
»
|

# D@ coosawareress

& g! Piaces of rterest ] -

& 10D more S 008 D\ or 131G lobs

Biwrn 2008 g DuiatS snsen £1yia PIVA Google

yo a
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OBTAINING AN AERIRHOTO USING GOOGARH

1. Start Google Earth and browse to your farms location.

™ Google Earth
File Edit View Tools Add Help

| Australia| = Q@
What you are looking for

5
Image © 2008 DigitalGlobe sy

©2008 MapData Sciences Ftylitd, PSMA . Y G [ 1
) « GOOgIE

55 H 339979.46 m E 5992120.71 m S elev 104 m i Eye alt 985m

Lostart| B @ oo wv [O] v Adviser - [demofarm] || & Google Earth « @y 9:34AM

2. hyOS @2dzNJ FINY A& Of SINIeé& @AaraofsS LINBaa (K

3. Open Microsoft Paint by clicking on the Start Menu button, then navigating to All
Programs>Accesses and selecting Paint from the list.
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4, Once in paint press Ctrl + V on your keyboard. The image of your farm should now appear in

the paint canvas.
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